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AKVIS COLORIAGE 14.0 | BILDEINFÄRBUNG UND FARBENÄNDERUNG

Bringen Sie Leben in Ihre Schwarz-Weiß-Fotos mit AKVIS Coloriage!

AKVIS präsentiert eine innovative Technologie zur  automatischen Fotoeinfärbung, die ihre Vorstellung von einer
Bildkolorierung für immer verändert.

AKVIS Coloriage bringt Farbe in Ihre Fotos: von der Einfärbung eines alten Schwarz-Weiß-Fotos aus Ihrem Familienalbum bis
hin zum Ersetzen von Farben in einem Farbfoto.

Bringen Sie Ihrer Großmutter Freude, indem Sie ihrem Klassenfoto Farbe hinzufügen. Verändern Sie die Farbe Ihres Autos, um
zu erfahren, wie es in Gelb aussehen würde. Entscheiden Sie, ob das rote Haar Ihnen steht.

AKVIS Coloriage erzeugt auf schnelle und unterhaltsame Weise realistische Einfärbungen. Mit AKVIS Coloriage kann man
Porträts ebenso wie Landschaftsaufnahmen,  Bekleidung und Stillleben umfärben. Voreinstellungen für Grünflächen-,
Baumrinden-, Haut- oder Himmelfarbe helfen Ihnen bei der Auswahl von realistischen Farben für Ihre Bilder.

Entfalten Sie Ihre Kreativität und entdecken Sie eine Vielzahl von weiteren Anwendungsmöglichkeiten. Sie können farbenfrohe
Hintergründe aus einfachen verschwommenen Bildern erstellen, den Rote-Augen-Effekt beseitigen sowie eine selektive
Farbkorrektur/Entsättigung/Einfärbung durchführen.
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AKVIS Coloriage ist sehr einfach zu benutzen, so wie ein Ausmalbuch. Kein Hantieren mit Ebenen, keine komplizierten
Techniken, kein stundenlanges Ausprobieren, um das von Ihnen gewünschte Aussehen zu erhalten - alles ist mit ein paar
Pinselstrichen erledigt. Hauptaufgabe besteht in der Feststellung von Farbbereichen.

Markieren Sie die Objekte zum Umfärben mit jeweiligen Farben und starten dann die Bildbearbeitung. Das Programm erledigt
den Rest: erkennt die Ränder des Objekts und passt die Farbe der Graustufenpalette des ursprünglichen Bildes an.
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Benutzen Sie AKVIS Coloriage für folgende Zwecke:

Schwarz-Weiß-Fotos kolorieren;

Bleistiftzeichnungen ausmalen (Buchillustrationen, Manga und Comics);

Farben in einem Farbfoto ersetzen;

verschiedene Farben für Innenraum-Gestaltung und Außenarchitektur ausprobieren;

selektives Ent- oder Einfärben erstellen.

Die Liste der Anwendungen ist praktisch unendlich. Experimentieren Sie mit der Software, um ihr volles Potenzial zu
verwirklichen!
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Das Programm steht in zwei Versionen zur Verfügung – als ein eigenständiges Programm (Standalone) und als Zusatzprogramm
(Plugin).

Die Plugin-Version ist mit AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro sowie mit anderen
Bildbearbeitungsprogrammen kompatibel, die Plugins von Drittanbietern integrieren. 
Konsultieren Sie die Kompatibilitätstabelle für weitere Details.

Die Funktionalität des Programms hängt von einem Lizenztyp ab. Weitere Informationen dazu finden Sie hier.
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INSTALLATION UNTER WINDOWS

Nachfolgend finden Sie Anweisungen zur Installation der Programme von AKVIS unter Windows. Wir haben AKVIS Coloriage
als Beispiel genommen. Andere AKVIS-Programme lassen sich auf die gleiche Weise installieren.

 

Sie müssen über Administratorrechte verfügen, um das Programm auf Ihrem Computer zu installieren.

Bevor Sie die AKVIS-Plugins installieren, vergewissern Sie sich bitte, dass der Bildeditor, in dem Sie die Plugins installieren
möchten, geschlossen ist. Oder führen Sie den Bildeditor nach der Installation des Plugins erneut aus.

 

1. Starten Sie die ausführbare Setupdatei (mit .exe-Dateiendung).
2. Wählen Sie die Sprache aus und klicken Sie auf Installieren, um den Installationsvorgang zu starten.
3. Um den Installationsvorgang fortzusetzen, müssen Sie die Lizenzbedingungen durchlesen und akzeptieren.

Aktivieren Sie das Kontrollkästchen "Ich stimme den Bedingungen der Lizenzvereinbarung zu" und klicken Sie auf
Weiter.

4. Um das Plugin zu installieren, wählen Sie Ihre Bildbearbeitungssoftware aus der Liste aus.

Um die Standalone-Version zu installieren, stellen Sie sicher, dass das Kontrollkästchen Standalone aktiviert ist. 
Um eine Verknüpfung des Programms auf dem Desktop zu erstellen, aktivieren Sie den Punkt  Verknüpfung auf
Desktop.

Klicken Sie auf die Schaltfläche Weiter.
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5. Klicken Sie auf die Schaltfläche Installieren.

6. Die Installation ist gerade im Gange.
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7. Die Installation ist beendet.

Sie können AKVIS Newsletter abonnieren, um Informationen über neue Produkte und spezielle Angebote aus erster
Hand zu erhalten. Geben Sie Ihre Email-Adresse ein.

8. Klicken Sie auf Fertig stellen, um das Setup zu beenden.

Nach der Installation der Standalone-Version von AKVIS Coloriage sehen Sie einen neuen Eintrag im Menü Start: AKVIS -
Coloriage. Auf dem Desktop erscheint das Symbol der Verknüpfung, wenn Sie während der Installation das Kästchen
Verknüpfung auf Desktop aktiviert haben.

Nach der Installation der Plugins-Version von Coloriage sehen Sie einen neuen Eintrag im Filter/Effekte-Menü Ihrer
Bildbearbeitungssoftware. Z.B. in Photoshop: Filter -> AKVIS –> Coloriage, in AliveColors: Effekte -> AKVIS –>
Coloriage.
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INSTALLATION UNTER MAC

Befolgen Sie die Anweisungen zur Installation der AKVIS-Software unter Mac. Wir haben AKVIS Coloriage als Beispiel
genommen. Andere AKVIS-Programme lassen sich auf die gleiche Weise installieren.

Sie müssen über Administratorrechte verfügen, um das Programm auf Ihrem Computer zu installieren.

 

1. Öffnen Sie die virtuelle dmg-Disk:

- akvis-coloriage-app.dmg, um die eigenständige Standalone-Version zu installieren.

- akvis-coloriage-plugin.dmg, um die Plugin-Version in einem Bildbearbeitungsprogramm zu installieren.

2. Lesen Sie die Lizenzvereinbarung und klicken Sie auf Akzeptieren, wenn Sie die Bedingungen annehmen.

3. Finder öffnet sich und Sie sehen einen Ordner mit Dateien: AKVIS Coloriage Application oder AKVIS Coloriage
Plugin.

 

4. Um die Standalone-Version zu installieren, ziehen Sie AKVIS Coloriage Application in den Ordner Programme oder
ein Verzeichnis Ihrer Wahl.

Um die Plugin-Version zu installieren, ziehen Sie den ganzen Ordner AKVIS Coloriage Plugin in den Plug-Ins Ordner
Ihres Bildbearbeitungsprogramms:

AliveColors: Sie können den Ordner für Plugins in den Optionen des Programms auswählen.

Photoshop CC 2023, CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC.

Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins.

Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins unter Mac
(klicken um zu vergrößern)

Nach der Installation des Plugins AKVIS Coloriage sehen Sie einen neuen Eintrag in dem Filter/Effekte-Menü Ihres
Bildbearbeitungsprogramms. Wählen Sie in Photoshop: Filter -> AKVIS -> Coloriage, in AliveColors: Effekte -> AKVIS ->
Coloriage aus.

Führen Sie die Standalone-Version aus, indem Sie im Finder auf das entsprechende Symbol doppelklicken.

Sie können das AKVIS-Programm auch über die  Photos-App ausführen, indem Sie den Befehl  Bild -> Bearbeiten mit
auswählen (in High Sierra und späteren Versionen von macOS).
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INSTALLATION UNTER LINUX

Befolgen Sie die Anweisungen, um die AKVIS-Software auf einem Linux-Computer zu installieren.

Hinweis: Die AKVIS-Programme sind mit Linux kernel 5.0+ 64-Bit kompatibel. Sie können die Kernel-Version mit dem
Befehl uname -srm herausfinden.

Wir haben AKVIS Coloriage als Beispiel genommen. Andere AKVIS-Programme werden auf die gleiche Weise installiert.
Ersetzen Sie einfach coloriage durch den Produktnamen (Kleinbuchstaben ohne Leerzeichen), z. B. noisebuster,
sketchvideo usw.

 

Installation auf Debian-basierten Systemen:

Hinweis: Sie benötigen apt-install- oder apt-get-Berechtigungen, um Software zu installieren.

1. Führen Sie das Terminal aus.
2. Erstellen Sie ein Verzeichnis zum Speichern von Schlüsseln: 

sudo mkdir -p /usr/share/keyrings
3. Laden Sie den Schlüssel herunter, mit dem das Repository signiert wurde: 

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 
oder wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null

4. Fügen Sie das Repository der Liste hinzu, in der das System nach zu installierenden Paketen sucht: 
echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-
deb.sfo2.cdn.digitaloceanspaces.com akvis non-free' | sudo tee /etc/apt/sources.list.d/akvis.list

5. Aktualisieren Sie die Liste der bekannten Pakete: 
sudo apt-get update

6. Installieren Sie AKVIS Coloriage: 
sudo apt-get install akvis-coloriage

7. Die Installation ist abgeschlossen.

Starten Sie das Programm über das Terminal oder über die Programmverknüpfung.

8. Für automatische Updates verwenden Sie den Befehl: 
sudo apt-get upgrade

So entfernen Sie das Programm: 
sudo apt-get remove akvis-coloriage --autoremove

 

Installation auf RPM-basierten Systemen (CentOS, RHEL, Fedora):

1. Führen Sie das Terminal aus.
2. Registrieren Sie den Schlüssel, mit dem das Repository signiert wurde: 

sudo rpm --import https://akvis.com/akvis.asc
3. Fügen Sie das Repository dem System hinzu: 

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo
4. Aktualisieren Sie die Paketliste:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf update

beim Verwenden des yum-Paketmanagers: 
sudo yum update

5. Installieren Sie AKVIS Coloriage:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf install akvis-coloriage

beim Verwenden des yum-Paketmanagers: 
sudo yum install akvis-coloriage

6. Die Installation ist abgeschlossen.

Starten Sie das Programm über das Terminal oder über die Programmverknüpfung.

7. Für automatische Updates verwenden Sie den Befehl:

beim Verwenden des dnf-Paketmanagers: 
sudo dnf upgrade

beim Verwenden des yum-Paketmanagers: 
sudo yum upgrade

8. So entfernen Sie das Programm:

beim Verwenden des dnf-Paketmanagers: 
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sudo dnf remove akvis-coloriage

beim Verwenden des yum-Paketmanagers: 
sudo yum remove akvis-coloriage

 

Installation auf openSUSE.

1. Führen Sie das Terminal aus.
2. Melden Sie sich als Root-Benutzer an.
3. Fügen Sie den Schlüssel hinzu, mit dem das Repository signiert wurde: 

rpm --import http://akvis.com/akvis.asc
4. Fügen Sie das Repository dem System hinzu: 

zypper ar -r https://akvis.com/akvis.repo akvis
5. Aktualisieren Sie die Paketliste: 

zypper ref
6. Installieren Sie AKVIS Coloriage: 

zypper install akvis-coloriage
7. Die Installation ist abgeschlossen.

Starten Sie das Programm über das Terminal oder über die Programmverknüpfung.

8. Für automatische Updates: 
zypper update

So entfernen Sie das Programm: 
zypper remove akvis-coloriage

 

Um die Programmoberfläche korrekt anzuzeigen, empfiehlt es sich, den Compton oder Picom Composite-Manager zu
installieren.
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SO AKTIVIERT MAN AKVIS SOFTWARE

Achtung! Während des Aktivierungsvorgangs muss Ihr Computer mit dem Internet verbunden sein.

Wenn Ihr Computer keinen Internetzugang hat, bieten wir Ihnen eine alternative Aktivierungsmöglichkeit an (siehe unten
Aktivierung ohne Internetzugang).

 

Laden Sie AKVIS Coloriage herunter und installieren Sie das Programm. Bevor Sie mit der Installation beginnen, lesen Sie die
Installationsanleitung.

Jedes Mal, wenn Sie eine unregistrierte Version starten, wird das Anfangsfenster angezeigt. Hier finden Sie allgemeine
Informationen über die Version des Programms und die Anzahl der restlichen Tage bis zum Ablauf der Testzeit.

Außerdem können Sie das Fenster Über das Programm öffnen, indem Sie auf die Schaltfläche   in der Optionsleiste des

Programms klicken.

 

Klicken Sie auf TESTEN, um die Software zu evaluieren. Ein neues Fenster mit Lizenz-Varianten zum Testen wird angezeigt.

Sie können das Programm ohne Anmeldung und Registrierung während der Testperiode ausprobieren (10 Tage nach dem ersten
Start).

Während der Testperiode können Sie alle Optionen testen und entscheiden, welcher Lizenztyp Ihren Bedürfnissen am besten
entspricht. Wählen Sie eine der angebotenen Lizenztypen: Home (Plugin oder Standalone), Home Deluxe, oder Business.
Die Funktionalität des Programms hängt von einem Lizenztyp ab. Für eine detailliertere Übersicht konsultieren Sie bitte die
Vergleichstabelle.

 

Klicken Sie auf KAUFEN, um eine Lizenz zu bestellen.

Sobald die Zahlung erfolgt ist, erhalten Sie Ihre persönliche Seriennummer an Ihre E-mail-Adresse innerhalb weniger Minuten.

 

Klicken Sie auf AKTIVIEREN, um den Aktivierungsvorgang zu starten.
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Geben Sie Ihren Namen ein (das Programm wird auf diesen Namen registriert).

Geben Sie Ihre Seriennummer (Ihren Lizenzschlüssel) ein.

Wählen Sie eine Aktivierungsmethode — entweder direkte Verbindung zum Aktivierungsserver oder per E-Mail.

Direkte Verbindung zum Aktivierungsserver:

Es ist die einfachste Möglichkeit der Aktivierung.

Bei dieser Aktivierungsmethode muss Ihr Computer mit dem Internet verbunden sein.

Drücken Sie auf AKTIVIEREN.

Die Aktivierung ist nun abgeschlossen!

Aktivierungsanfrage per E-Mail senden:

Falls Sie die Aktivierung per E-Mail ausgewählt haben, erstellt das Programm eine Nachricht mit allen notwendigen
Informationen.

HINWEIS: Sie können diese Methode auch bei der Aktivierung ohne Internetzugang nutzen.

Wenn Ihr Computer nicht mit dem Internet verbunden sind, übertragen Sie die Aktivierungsanfrage auf einen anderen
Computer mit Internetzugang, z.B. per USB-Stick. Senden Sie uns diese Anfrage an: activate@akvis.com.

Bitte senden Sie keine Screenshots! Man muss den Text einfach kopieren und speichern.

Wir brauchen Ihre Seriennummer für die Software, Ihren Namen und Hardware ID (HWID) Ihres Computers.

Eine Lizenzdatei (Coloriage.lic) wird erstellt und Ihnen per E-Mail übersendet.

Speichern Sie die erhaltene .lic-Datei auf einen USB Stick und verlegen sie auf den Computer, auf welchem Sie das
Programm aktivieren möchten. Öffnen Sie die Datei nicht! Legen Sie die Lizenzdatei im AKVIS-Ordner ab:

Windows:

C:\Users\Public\Documents\AKVIS

(Dieser PC > Lokale Festplatte (C:) > Benutzer > Öffentlich > Dokumente > AKVIS)

Mac:

/Users/Shared/AKVIS

Öffnen Sie den  Finder, wählen Sie das Menü  Gehe zu, wählen Sie dann  Gehe zum Ordner...
(⌘ +Shift+G ), geben Sie "/Users/Shared/AKVIS" ein und klicken Sie auf Öffnen.

Linux:

/var/lib/AKVIS

Die Aktivierung ist nun abgeschlossen!
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Nach der Aktivierung wird die Schaltfläche KAUFEN durch die Schaltfläche UPGRADE ersetzt. Mithilfe dieses Buttons können
Sie Ihre Lizenz verbessern (beispielsweise Home-Lizenz auf Home Deluxe oder Business upgraden).
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ARBEITSBEREICH

AKVIS Coloriage steht in zwei Versionen zur Verfügung - als ein  eigenständiges Programm (Standalone) und als
Zusatzprogramm (Plugin).

Standalone ist ein eigenständiges Programm. Klicken Sie auf das Symbol des Programms, um es zu öffnen.
Plugin ist ein Zusatzmodul zur Integration in ein Bildbearbeitungsprogramm. Um das Plugin aufzurufen, wählen Sie es im
Filter-Menü Ihres Bildbearbeitungsprogramms.

Das Programmfenster von AKVIS Coloriage sieht wie folgt aus:

Der größte Teil der Arbeitsfläche wird vom  Bildfenster mit den Registerkarten Original und Ergebnis eingenommen. Im
Original-Register sieht man das Originalfoto mit den Farbmarkierungen für das Einfärben. Das Register Ergebnis zeigt das
resultierende Bild. Man kann zwischen den Registern mit einem Klick auf jeweiligen Registernamen umschalten.

 

Im oberen Teil des Programmfensters sehen Sie die Optionsleiste mit folgenden Schaltflächen:

Die Schaltfläche   öffnet die Webseite von AKVIS Coloriage.

Mit der Schaltfläche   öffnet man ein Bild zur Bearbeitung (nur in der Standalone-Version). Der Hotkey ist  Strg+O

unter Windows, ⌘ +O  unter Mac.

Mit der Schaltfläche   speichert man das bearbeitete Bild auf der Disk (nur in der Standalone-Version). Der Hotkey

ist Strg+S  unter Windows, ⌘ +S  unter Mac.

Mit der Schaltfläche   kann man das bearbeitete Bild drucken (nur in der Standalone-Version). Der Hotkey ist

Strg+P  unter Windows, ⌘ +P  unter Mac.

Mit der Schaltfläche   werden Dateien mit der Endung .strokes geöffnet. In diesen Dateien können Sie Ihre

Markierungslinien für ein Bild speichern.
Die Schaltfläche   erlaubt das Speichern der Markierungslinien eines Bildes in einer Datei mit der Endung .strokes.

Das Speichern der Farbmarkierungen ist empfehlenswert, wenn Sie das Bild später redigieren wollen.
Die Schaltfläche   macht die letzten Änderungen rückgängig. Es ist möglich, mehrere Änderungen nacheinander zu

annullieren. Die einzige Änderung wird mit der Tastenkombination Strg+Z  unter Windows, ⌘ +Z  unter Mac rückgängig
gemacht.
Mit der Schaltfläche   kann der aufgehobene -Befehl wiederhergestellt werden. Sie können auch den Kurzbefehl

Strg+Y  unter Windows, ⌘ +Y  unter Mac benutzen.

Die Schaltfläche   /  /  wechselt zwischen zwei Ansichtsmodi der Markierungslinien. 

Wenn das Symbol  angezeigt wird, wird der Modus Standardvorschau aktiviert. Dabei werden die Markierungen so

angezeigt, wie in der Farbe-Palette. 
Wenn das Symbol  angezeigt wird, wird der Modus Helligkeit der Markierungen anpassen aktiviert. In diesem

Modus werden die Markierungslinien so angezeigt, wie sie im Ergebnisbild aussehen werden. Dabei ist zu beachten, dass
das Programm die Farben der ursprünglichen Helligkeit des Bildes anpasst. Deshalb können die hellen Farben in den hellen
Bereichen und die dunklen Farben in den dunklen Bereichen in diesem Modus kaum sichtbar sein. 
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Indem Sie den Modus Markierungen ausblenden  aktivieren, werden die Markierungen unsichtbar.

Mit der Schaltfläche   wird der Einfärbprozess gestartet. Die schnelle Tastenkombination ist Strg+R  unter Windows,

⌘ +R  unter Mac. Das resultierende Bild erscheint dann im Register Ergebnis.

Mit einem Klick auf die Schaltfläche   werden die Änderungen angenommen und das Fenster wird geschlossen.

Die Schaltfläche   ruft Informationen über das Programm auf.

Die Schaltfläche   ruft die Hilfe auf.

Die Schaltfläche   ruft das Dialogfenster Optionen auf.

Die Schaltfläche   öffnet ein Fenster mit den neuesten Nachrichten über Coloriage.

 

Auf der linken Seite des Bildfensters befindet sich die Werkzeugpalette, die Werkzeuge zum Zeichnen und Bearbeiten von
Strichen sowie Werkzeuge zum Bearbeiten des kolorierten Bildes enthält.

Die Einstellungen des aktiven Werkzeugs werden im schwebenden Fenster angezeigt. Man kann dieses Fenster mit dem
rechten Mausklick auf jeden beliebigen Punkt des Bildfensters aufgerufen werden. Wenn Sie außerhalb des schwebenden
Fensters klicken, wird das Menü ausgeblendet.

 

Im Navigator-Fenster kann man das Bild skalieren. Der Rahmen zeigt den Bereich des Bildes, der im Bildfenster angezeigt
wird. Wenn Sie den roten Rahmen über das Bild verschieben, ändert sich der sichtbare Bereich des Bildes. Um den roten
Rahmen zu verschieben, bringen Sie den Cursor in den Rahmen hinein und ziehen Sie den Rahmen bei gedrückter Maustaste.

Navigator-Fenster

Verwenden Sie den Schieberegler, um das Bild im Bildfenster zu skalieren. Wenn Sie den Schieberegler nach rechts bewegen,
erhöht sich der Bildmaßstab. Wenn Sie den Schieberegler nach links bewegen, verringert sich der Bildmaßstab.

Um das Bild im Bildfenster zu scrollen, können Sie die Leertaste auf der Tastatur drücken und das Bild mit der linken Maustaste
ziehen. Mit dem Scrollrad der Maus verschieben Sie das Bild nach oben/unten, indem Sie die Strg -Taste gedrückt halten
(Mac: ⌘ ) – nach links/rechts, indem Sie die Alt-Taste gedrückt halten (Mac:  Option ) − skalieren Sie das Bild. Mit einem
Rechtsklick auf die Bildlaufleiste erscheint das Schnellnavigation-Menü.

Sie können den Bildmaßstab auch ändern, indem Sie einen neuen Koeffizienten in das Maßstabsfeld eingeben und die
Eingabetaste  (Return  unter Mac) drücken. Das Dropdown-Menü zeigt einige häufig verwendete Koeffizienten.

Sie können Hotkeys verwenden, um den Bildmaßstab zu ändern:  +  und Strg++  (⌘ ++  unter Mac), um den Bildmaßstab zu
erhöhen und -  und Strg+-  (⌘ +-  unter Mac), um den Maßstab zu verringern.

 

Unter dem Navigator gibt es die Einstellungsleiste mit den Registerkarten Kolorierung und Vorverarbeitung.

Die Registerkarte Kolorierung dient zum Arbeiten mit Farben. Hier gibt es folgende Paletten: Farbbibliothek und
Musterbild, Zuletzt verwendete Farben sowie Farbe, Farbfelder und Multifarben.
Die Registerkarte Vorverarbeitung enthält Parameter für die Vorverarbeitung des Bildes.
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SCHWARZWEISSFOTOS KOLORIEREN

AKVIS Coloriage steht in zwei Versionen zur Verfügung - als ein  eigenständiges Programm (Standalone) und als
Zusatzprogramm (Plugin).

Folgen Sie der Anweisung, um das Foto mit AKVIS Coloriage einzufärben:

Schritt 1. Öffnen Sie ein Bild zur Bearbeitung.

- In der Standalone-Version (BMP-, JPEG-, PNG-, TIFF-, RAW-Dateien):

Um ein Bild zu laden, können Sie im leeren Fenster doppelklicken, das Bild in den Programmarbeitsbereich ziehen oder 
 verwenden. Die Software unterstützt folgende Dateiformate: RAW, JPEG, PNG, BMP, TIFF und WEBP.

- In der Plugin-Version:

Öffnen Sie ein Bild in Ihrem Bildbearbeitungsprogramm mit dem Befehl  Datei -> Öffnen oder  mit  der
Tastenkombination Strg+O .

Wenn das Bild im Grayscale/Graustufen-Modus ist, konvertieren Sie es in den RGB-, CMYK- oder Lab-Modus.

Rufen Sie das Plugin auf:

in AliveColors: Effekte -> AKVIS -> Coloriage; 
in Adobe Photoshop: Filter -> AKVIS -> Coloriage; 
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> Coloriage; 
in Corel Photo-Paint: Effects -> AKVIS -> Coloriage.

Hinweis: Die bereits in Ihrem Bildbearbeitungsprogramm erstellte Auswahl wird in das Plugin übernommen und als
die mit dem Farberhaltungsstift  erstellte Umrisslinie angezeigt.

Schritt 2. Bei Bedarf können Sie die Helligkeit und den Kontrast des Bildes in der Registerkarte  Vorverarbeitung
anpassen.
Schritt 3. Wählen Sie auf der Registerkarte Kolorierung Farben für das Objekt aus, das Sie einfärben möchten.

AKVIS Coloriage bietet mehrere Möglichkeiten, Farben auszuwählen: in der Farbbibliothek, in den Farbe-, Farbfelder-
und Multifarben-Paletten, im Farbauswahldialog und aus dem Musterbild mit der Farbpipette-Werkzeug .

Schritt 4. Markieren Sie die Bildbereiche mit den Vorbearbeitungswerkzeugen aus der Werkzeugpalette (auf der
Registerkarte Original). Wenn Sie für ein Objekt keine Farbe auswählen, wird es in der Farbe der nächstgelegenen
Objekte eingefärbt.
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Schritt 5. Klicken Sie die Schaltfläche  , um die Verarbeitung zu starten. Das kolorierte Bild wird auf der

Registerkarte Ergebnis angezeigt.

Wenn Sie das Verarbeitungsergebnis bearbeiten möchten (einige Striche entfernen, neue Striche hinzufügen, die Farbe
der Objekte ändern), wechseln Sie auf die Registerkarte Original und nehmen Sie die erforderlichen Korrekturen vor.
Klicken Sie die Schaltfläche   erneut.

Schritt 6. Es ist möglich, das Ergebnis der Einfärbung zu der Liste der Färbungsvarianten hinzuzufügen, indem Sie auf 
 in der Werkzeugleiste klicken. Sie können zwischen den Ergebnissen wechseln, um verschiedene Versionen der

Einfärbung zu vergleichen.
Um ein Bild aus der Liste zu entfernen, klicken Sie auf .

Achtung: Diese Funktion steht nur für Home Deluxe- und Business-Lizenzen zur Verfügung.

Färbungsvarianten

Hinweis:

Laden eines neuen Bildes in das Programm entfernt alle Bilder aus der Liste. Speichern Sie die bevorzugten
Ergebnisse unter neuen Namen.

Sie können Färbungsvarianten in den Optionen des Programms  ausblenden.

Schritt 7. In der letzten Arbeitsstufe können Sie das Bild manuell mit den Nachbearbeitungswerkzeugen bearbeiten:
Färbungspinsel , Korrekturpinsel  und Protokollpinsel . Die Werkzeuge sind in der Registerkarte Ergebnis

anwendbar.

Achtung! Verwenden Sie diese Werkzeuge im letzten Schritt! Wenn Sie die Verarbeitung erneut ausführen oder
zwischen den Bildern in Färbungsvarianten wechseln, gehen die mit den Werkzeugen vorgenommenen
Änderungen verloren.

Schritt 8. Sie können die Markierungen speichern (wenn Sie z.B. weitere Änderungen etwas später vornehmen wollen).
Drücken Sie dafür auf  . Sie haben dann die Möglichkeit, die Markierungslinien mit   wieder zu laden und die Arbeit

fortzusetzen.

Im Falle eines unerwarteten Ereignisses (z. B. Stromausfall usw.) speichert das Programm die Striche jedes Mal
automatisch in der Datei coloriage-autosave.strokes, wenn Sie die Verarbeitung ausführen  .
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Schritt 9. In der Standalone-Version können Sie Ihr Ergebnis auch   drucken.

Schritt 10. Speichern Sie das Bild.

- In der Standalone-Version:

Klicken Sie auf die Schaltfläche  , um das Dialogfeld Speichern unter zu öffnen. Geben Sie einen Dateinamen

ein, wählen Sie eines der Formate (JPEG, TIFF, BMP, PNG oder WEBP) aus und legen Sie den Zielordner fest.

- In der Plugin-Version:

Drücken Sie auf  , um das Ergebnis anzuwenden und das Plugin-Fenster zu schließen. Das AKVIS Coloriage-

Plugin wird geschlossen und das bearbeitete Bild wird im Arbeitsbereich Ihrer Bildbearbeitungssoftware angezeigt.

Rufen Sie das Dialogfeld Speichern unter mit dem Befehl Datei -> Speichern unter auf. Geben Sie einen
Dateinamen ein, wählen Sie das Format aus und legen Sie den Zielordner fest.

Das eingefärbte Foto
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FARBAUSWAHL IN AKVIS COLORIAGE

AKVIS Coloriage bietet mehrere Möglichkeiten zur Farbauswahl: die  Farbe-Palette, die Farbfelder-Palette, die
Farbbibliothek. Darüber hinaus können Sie Farben direkt aus dem Musterbild mit der Farbpipette aufnehmen.

Hinweis: Die Farben eines Fotos wirken realistischer, wenn Sie weniger gesättigte Farben beim Kolorieren verwenden.

 

Die Palette Zuletzt verwendete Farben merkt sich die zuletzt verwendeten Farben. Sobald mit einer Farbe gezeichnet wird,
wird diese in der neuen Palette angezeigt, sodass Sie schneller darauf zugreifen können.

 

Farbe-Palette

Um eine Farbe anhand dieser Palette zuweisen, kann man eine Farbe aus einem Farbspektrum auswählen. Wenn Sie mit der
Maus über die Farbe-Palette gehen, verändert sich der Mauszeiger zu einer Pipette. Um eine neue Farbe zu wählen, klicken Sie
einfach mit der Pipette auf die gewünschte Farbe des Spektrums. Die aktuelle Farbe wird im rechteckigen Farbfeld angezeigt.
Wenn Sie darauf doppelklicken, wird das Farbauswahldialog aufgerufen.

Sie können den Farbton einer Farbe ändern oder eine ganz neue Farbe erhalten, indem Sie die Schieberegler anpassen oder
neue Werte für Farbkomponenten in die Eingabefelder eingeben.

Mit einem Rechtsklick wird das Menü der verfügbaren Farbmodi geöffnet: Graustufen, RGB, CMYK und Lab.

Die Farbverlaufslinie über die Farbe-Palette zeigt die ausgewählte Farbe und ihre Schattierungen je nach Helligkeit.

Anhand der unteren Farbverlaufslinie kann man die Farbtiefe anpassen. Standardmäßig ist der Helligkeitsbereich voll, d.h., die
schwarzen Pixel auf dem Bild entsprechen den dunkelsten Farbtönen der gewählten Farbe, während die weißen Pixel den
hellsten Farbtönen entsprechen.

Um den Helligkeitsbereich zu ändern, muss man den schwarzen bzw. weißen Punkt auf der Abstufungslinie verschieben. So
wird der dunkelste bzw. hellste Farbton für das Objekt eingestellt. Wenn man einen dunkleren Farbton für den weißen Punkt
zuweist, kann man einen hellen Bereich in eine dunkle Farbe einfärben; wenn man eine hellere Farbe für den schwarzen Punkt
einstellt, kann man einen dunklen Bereich in eine helle Farbe umfärben.
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Sie können Ihre Lieblingsfarben oder häufig verwendete Farben in einer speziellen Minipalette speichern.

Um eine Farbe in die Minipalette hinzuzufügen, ziehen Sie die ausgewählte Farbe mit der linken Maustaste aus dem Farbmuster
in eine der Zellen. Um eine Farbe aus der Zelle auszuwählen, klicken Sie darauf mit der linken Maustaste. Um eine Farbe aus
der Zelle zu löschen, klicken Sie darauf mit der rechten Maustaste.

 

Farbfelder-Palette

In der Farbfelder-Palette sind häufig verwendete Farben dargestellt. Um eine Farbe aus der Palette auszuwählen, klicken Sie
darauf mit der linken Maustaste. Die ausgewählte Farbe im rechteckigen Farbfeld angezeigt.

Die Schaltflächen am unteren Rand der Palette haben folgende Verwendungszwecke:

Mit der Schaltfläche Farbfeld hinzufügen  wird die aktuelle Farbe zur Farbfeldsammlung hinzugefügt.

Um eine Farbe zu löschen, ziehen Sie diese in den Mülleimer   oder wählen Sie den Befehl Farbfeld löschen im Menü.

Die Schaltfläche In Datei speichern  öffnet ein Dialogfenster, in dem Farbfelder gespeichert werden können (Dateien

mit der Endung .swatches).
Die Schaltfläche Aus Datei laden  lädt eine gespeicherte Sammlung von Farbfeldern, sodass sie erneut verwendet

werden können.
Die Schaltfläche Zurücksetzen  stellt die ursprünglichen Einstellungen wiederher.

 

Farbbibliothek

Die Farbbibliothek enthält die Farben, die ziemlich schwierig auszuwählen sind: die Farben der Haut, des Haars, der Lippen,
des Holzes usw. Die Farben in der Farbbibliothek werden in Gruppen eingeteilt. Um eine Farbe aus der Farbbibliothek
auszuwählen:

Wählen Sie eine Farbgruppe, indem Sie diese anklicken. Die Farben in der Gruppe werden in Form der Farbverlaufslinie
dargestellt.
Wählen Sie eine Farbverlaufslinie aus, indem Sie darauf klicken. Die ausgewählte Farbverlaufslinie wird in der oberen
Farbverlaufslinie unter der Farbbibliothek widerspiegelt. Der Marker zeigt die Farbe, die Sie angeklickt haben.
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Wählen Sie eine Farbe aus der Farbverlaufslinie, indem Sie jeden beliebigen Punkt der oberen Farbverlaufslinie anklicken.
Die ausgewählte Farbe wird mit dem Marker bezeichnet. Die untere Farbverlaufslinie zeigt die Helligkeitsabstufungen
dieser Farbe.

Um eine Farbverlaufslinie in einer separaten Gruppe zu speichern, wählen Sie sie aus und klicken Sie auf die Schaltfläche
Zu Favoriten hinzufügen. Um eine Farbverlaufslinie aus der Favoriten-Gruppe zu löschen, wählen Sie sie aus und
klicken Sie auf die Schaltfläche Aus Favoriten entfernen.

 

Musterbild

In dieser Registerkarte können Sie mit der Pipette   Farben aus jedem anderen Bild auswählen. Das aktive Werkzeug (z. B.

Bleistift ) zeichnet mit der ausgewählten Farbe.

Laden Sie ein Bild mit  oder doppelklicken Sie auf den leeren Bereich in dieser Registerkarte oder ziehen Sie das Bild in

diese Registerkarte. Klicken Sie mit der rechten Maustaste auf die Schaltfläche  , um eine Liste der zuletzt verwendeten

Dateien anzuzeigen.

Um das Musterbild zu vergrößern oder zu verkleinern, verwenden Sie die Dropdown-Liste.
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Farbpipette

Zudem können Sie eine Farbe direkt aus dem Originalbild auswählen. Dafür aktivieren Sie die Farbpipette  und klicken Sie

damit auf einen beliebigen Punkt des Bildes oder auf eine bereits gezeichnete Markierungslinie.

Wenn das Tool über die Abbildung geführt wird, erscheint neben dem Mauszeiger ein Farbkreis mit 5 Sektoren, der folgende
Informationen über die Farben in diesem Bereich enthält:

1. Farbverlauf. In der Mitte ist die ausgewählte Farbe. Linker Rand - +30% Schwarz, rechter Rand - +30% Weiß.

2. Vorhergehende Farbe.

3. Farbe des Pixels, über dem der Mauszeiger schwebt.

4. Farben der Nachbarpixels.

5. Mittelfarben der Bereiche: 3x3, 5x5, 11x11, 31x31, 51x51, 101x101 px.

Hinweis: Indem Sie die Taste Strg  gedrückt halten, können Sie eine beliebige Farbe aus dem Farbkreise mit einem
Mausklick zur Liste hinzuzufügen.

 

Und noch einmal: Die Farben im Foto sehen natürlicher aus, wenn Sie weniger gesättigte Farben auswählen.

 

AKVIS Coloriage

25



Farbbild (Kontrollkästchen ist deaktiviert) Schwarz-Weiß-Bild (Kontrollkästchen ist aktiviert)

Helligkeit = -50 Helligkeit = 50

Kontrast = -50 Kontrast = 50

VORVERARBEITUNG

Die Registerkarte Vorverarbeitung enthält Parameter für die Vorverarbeitung, die dabei helfen, ein Originalbild vor der
Kolorierung zu verbessern. Sie können ein Farbfoto in Graustufen umwandeln sowie die Bildhelligkeit und den Kontrast
anpassen.

 

Graustufen. Aktivieren Sie das Kontrollkästchen, um das Originalbild in Schwarzweiß umzuwandeln.

Helligkeit. Die Stärke der Bildhelligkeit. Durch Erhöhen des Parameters werden die Pixel heller, durch Verringern werden
sie dunkler.

Kontrast. Durch Erhöhen des Parameters wird der Unterschied zwischen hellen und dunklen Bildbereichen vergrößert.
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WERKZEUGPALETTE

Die Werkzeugpalette ändert sich beim Wechsel zwischen den Registerkarten Original und Ergenbis und sieht wie folgt aus:

Werkzeuge in 

Original-Registerkarte

Werkzeuge in 

Ergenbis-Registerkarte

 

Alle Werkzeuge sind in drei Gruppen unterteilt: Vorbearbeitungswerkzeuge, Nachbearbeitungswerkzeuge und Hilfswerkzeuge.
Die Werkzeugoptionen werden durch einen Rechtsklick innerhalb des bearbeiteten Bildes angezeigt.

Hinweis:

Benutzen Sie die Schaltflächen   und , um die mit den Werkzeugen durchgeführten Aktionen rückgängig zu

machen oder wiederherzustellen: , , , , , , , .

 

Vorbearbeitungswerkzeuge (in der Original-Registerkarte):

Verwenden Sie diese Werkzeuge, um neue Bildfarben festzulegen und Bereiche zu schützen, die sich nicht ändern sollen.

Stift . Mit diesem Werkzeug zeichnen Sie Farbstriche und legen so die Farben fest, in denen die Objekte im Bild

eingefärbt werden sollen.

Legen Sie die Stiftgröße fest und ziehen Sie eine Umrisslinie an der Binnengrenze des Objekts hin. Wenn das
Objekt verschiedenfarbig ist, muss man jeden Bereich mit der jeweiligen Farbe markieren.

Wenn das Objekt sehr groß ist oder scharfe Grenzen aufweist (beispielsweise Helldunkel-Bereiche), dann malen Sie
einige Striche innerhalb des Objekts.

Wenn sich innerhalb des Objekts Details befinden, die in einer anderen Farbe eingefärbt werden sollen
(beispielsweise Lippen, Augen, Knöpfe einer Jacke), dann umranden Sie diesen Bereich mit der Hauptfarbe (z.B.
um Lippen oder Augen herum).
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Hinweis: Wenn Sie einen fließenden Farbverlauf brauchen (z.B. wenn Sie die Farbe des Himmels oder der Wiese
zuweisen), ziehen Sie die Striche ziemlich weit voneinander (je weiter die Striche sich voneinander befinden,
desto fließender ist der Übergang). Wenn Sie einen  schroffen Übergang brauchen (z.B. wenn Sie Augen oder
Lippen kolorieren), ziehen Sie die Markierungen nah aneinander.

Man muss beim Einfärben von Augen und Lippen solche Farben für die Konturen wählen, die der Gesichtshaut-
Farbe entsprechen. Sonst werden die angrenzenden Bereiche mit der Augen- oder Lippenfarbe gefärbt.

Es ist möglich, mehrere Farben auf einmal mit dem Stift-Werkzeug im Multifarben-Modus (nur für Home Deluxe
und Business Lizenzen) zu zuweisen. Es ist hilfreich, wenn Sie komplexe Muster oder Objekte mit klaren Grenzen
bearbeiten. Dieser Modus spart Ihnen Zeit.

Aktivieren Sie den Multifarben-Modus in den Optionen des Stift-Werkzeugs. Dabei wechselt die Einstellungsleiste
automatisch zur Multifarben-Palette.

Um die Farben festzulegen, fügen Sie sie zu Farbtafeln hinzu. Die linke Platte zeigt die zu ersetzende Farbe, die
rechte Platte zeigt die neue Farbe. Die Farben in den Farbtafeln können wie folgt ausgewählt werden:

- direkt aus dem Bild mit dem Farbpipette-Werkzeug (klicken Sie auf das Farbmuster und dann auf den
gewünschten Punkt im Bild); 
- im Farbauswahldialog, der mit einem Doppelklick auf das Farbmuster geöffnet wird; 
- aus der Farbbibliothek, die nach Kategorien unterteilte Farben enthält: Haut, Haaren, Lippen, Gras,
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Die Empfindlichkeit der Farbpaare:
Dunkelgrau — Rot = 75
Hellgrau — Weiß = 75

 

Die Empfindlichkeit der Farbpaare:
Dunkelgrau — Rot = 30
Hellgrau — Weiß = 90

Bäumen, Steinen usw.

Sie können den Parameter Empfindlichkeit für jedes Farbe-Paar anpassen. Je höher der Wert ist, desto mehr
Ausgangsfarbtöne werden beim Ziehen der Striche berücksichtigt.

 

Farberhaltungsstift . Verwenden Sie dieses Werkzeug, um Objekte und Bereiche zu markieren, die unverändert

bleiben sollen.

Wenn Sie ein einzelnes Objekt im Foto umfärben möchten, verwenden Sie das Stift-Werkzeug, um die Farbe des
Objekts festzulegen und ziehen Sie dann eine enge geschlossene Linie mit dem Farberhaltungsstift  um das

Objekt herum.

 

Farberhaltungsstift benutzt

 

Farberhaltungsstift nicht benutzt

 

Tube . Verwenden Sie dieses Werkzeug, um die Farbe und den Helligkeitsbereich des gezeichneten Strichs zu

ändern.

Zaubertube . Mit dem Werkzeug können Sie auf einmal die Farbe aller Striche ändern, die den gleichen Farb- und

Helligkeitsbereich haben.

Um die Farbe eines gezeichneten Strichs zu ändern, wählen Sie eine neue Farbe aus, wählen Sie dann das Tube-
Werkzeug  in der Werkzeugpalette aus und klicken Sie auf den Strich. Wenn es im Bild mehrere Striche

derselben Farbe gibt und Sie die Farbe aller dieser Striche ändern möchten, wählen Sie das  Zaubertube-

Werkzeug  aus und klicken Sie auf einen der Striche.
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Normale Vorschau

 

Helligkeitsvorschau

 

 

Farbwechsel von Rot zu Blau

Sie können die resultierende Farbe dunkler oder heller machen. Dazu müssen Sie den Helligkeitsbereich der
ausgewählten Farbe ändern. Dabei ist es zu beachten, dass die Kompression des Helligkeitsbereichs (besonders
wenn sie stark ist) unvermeidlich zur Verschlechterung der Detailgenauigkeit führt.

Um den Helligkeitsbereich eines gezeichneten Strichs zu ändern, sollten Sie den gewünschten Helligkeitsbereich
auswählen, das Tube-Werkzeug  aktivieren und mit der linken Maustaste auf diesen Strich klicken. Wenn Sie

Striche mit ein und derselben Farbe und Helligkeit neu einfärben möchten, wählen Sie das Zaubertube-Werkzeug 
 aus und klicken Sie mit der linken Maustaste auf einen der Striche. Um alle Striche mit derselben Farbe

unabhängig vom Helligkeitsbereich neu einzufärben, verwenden Sie dieses Werkzeug mit gedrückter  Strg -Taste

(⌘  auf Mac).

Im normalen Vorschaumodus werden alle Striche unabhängig von der Helligkeit in der gewählten Farbe dargestellt,
d.h. verschiedene Töne derselben Farbe sehen gleich aus. Wenn der Helligkeitsvorschau  aktiviert ist,

können Sie sehen, wie die Striche im resultierenden Bild aussehen.

 

Radiergummi . Verwenden Sie das Werkzeug, um gezeichnete Striche zu löschen.

 

Nachbearbeitungswerkzeuge (in der Ergebnis-Registerkarte):

Färbungspinsel . Das Werkzeug ermöglicht es, die Farben im kolorierten Bild zu ändern.

Die Parameter des Werkzeugs:
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Vor der Verwendung des Tools Färbungspinsel angewendet

Vor der Verwendung des Tools Korrekturpinsel angewedet

Größe (1-500). Der Parameter passt die Größe des Werkzeugs (in Pixeln) an.

Härte (0-100). Der Parameter legt die Härte der Pinselkante fest. Je höher der Wert des Parameters, desto härter
ist die Kante. Bei einem Wert von 100% ist der Pinsel beinahe so hart wie ein Bleistift; bei niedrigen Werten des
Parameters sind die Pinselstriche weich.

Stärke (0-100). Intensität der Pinselstriche. Je höher der Wert des Parameters, desto intensiver sind die Farben
der Striche.

Helligkeit. Wenn das Kontrollkästchen aktiviert ist, wird die Helligkeit der Striche an die allgemeine Helligkeit des
Bildes angepasst (die Striche in den hellen Bereichen werden heller, in den dunklen – dunkler). Wenn das
Kontrollkästchen deaktiviert ist, hängt die Helligkeit der Striche nicht von der Helligkeit des Bildes ab.

 

Korrekturpinsel  (nur für Home Deluxe und Business Lizenzen). Mit dem Werkzeug können Sie Objekte auf

natürliche Weise neu einfärben, Schattierungen und Halbtöne hinzufügen, Falten glätten und unnötige Details entfernen.

Die Parameter des Werkzeugs:

Größe (1-200). Die Größe des Werkzeugs.

Härte (0-100). Der Grad der Unschärfe der äußeren Kante des Pinsels. Je höher der Wert des Parameters, desto
härter ist die Kante.

Stärke (0-100). Der Einfluss auf ein Bild.

Glättungsradius (0,1-10,0). Bei niedrigen Werten glättet der Parameter große Details. Bei großen Werten glättet
er kleinere Details und behält große bei.

Muster (0-100). Beim Wert = 0 verwendet der Pinsel die Farbe vom Startpunkt des Strichs. Je höher der Wert des
Parameters, desto schwächer ist die Originalfarbe und desto heller erscheint die Farbe aus der Palette. Beim Wert
= 100 wird die Originalfarbe nicht verwendet.

Farbmischung (0-100). Der Grad der Mischung mit der ausgewählten Farbe.

 

Protokollpinsel . Das Tool stellt das Bild in seinem ursprünglichen Zustand wieder her.
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Vor der Verwendung des Tools Protokollpinsel angewendet

Die Parameter des Werkzeugs:

Größe (1-500). Die maximale Breite einer vom Pinsel erzeugten Linie.

Härte (0-100). Die Verschwommenheit der Kanten des Werkzeugs. Wenn der Wert bei 100% liegt, ist die Grenze
zwischen den Pinselkanten und dem Hintergrund sehr deutlich. Bei niedrigen Werten ist der Übergang zwischen
den Bereichen glätter.

Stärke (1-100). Der Grad der Wiederherstellung des ursprünglichen Zustandes. Bei niedrigeren Werten wird der
Bereich nicht vollständig wiederhergestellt, sondern der Effekt vermischt sich mit dem Originalbereich. Bei 100%
wird der ursprüngliche Zustand vollständig wiederhergestellt.

Original wiederherstellen. Wenn das Kontrollkästchen aktiviert ist, wird das Originalbild wiederhergestellt. Wenn
es deaktiviert ist, stellt das Tool das Ergebnis der automatischen Verarbeitung wieder her.

 

Hilfswerkzeuge (in beiden Registerkarten aktiv):

Farbpipette . Das Werkzeug ermöglicht die Auswahl von Farben direkt aus dem Bild.

Hand . Das Werkzeug wird verwendet, um den angezeigten Bereich des Bildes im Fenster zu verschieben, wenn das

ganze Bild in das Fenster bei diesem Maßstab nicht passt. Um das Bild zu scrollen, klicken Sie auf diese Schaltfläche,
bringen Sie den Cursor auf das Bild und verschieben Sie das Bild bei gedrückter Maustaste. Um das Werkzeug schnell zu
aktivieren, drücken Sie die Taste H  auf der Tastatur. 

Mit einem Doppelklick auf das Symbol des Werkzeugs  wird die Abbildung der Programmfenstergröße angepasst.

Zoom . Das Werkzeug ändert den Maßstab des Bildes. Um den Maßstab zu erhöhen, klicken Sie auf das Bild. Um den

Maßstab zu verringern, klicken Sie auf das Bild bei der gedrückten  Alt -Taste. Um das Werkzeug schnell zu aktivieren,

drücken Sie die Z -Taste auf der Tastatur. 

Mit einem Doppelklick auf das Symbol des Werkzeugs  wird die Abbildung in ihrer Originalgröße (100%) dargestellt.
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TIPPS UND TRICKS

Bitte folgen Sie diesen Colorieren-Tipps, um das Kolorieren der schwarz-weißen Fotos und das Umfärben der Farbbilder mit
dem Programm AKVIS Coloriage zu meistern.

 

Wenn Sie Farben für die Objekte zuweisen, beachten Sie bitte, dass die Ergebnisfarbe von der Graustufen des
Originalbildes abhängt (standardmäßig kann ein heller Bereich keine dunkle Farbe annehmen und umgekehrt kann sich ein
dunkler Bereich keiner helleren Farbe aneignen). Wenn Sie mit den endgültigen Farben nicht zufrieden sind (wenn z.B. die
endgültige Farbe zu dunkel oder zu hell ist), können Sie den Helligkeitsbereich der Farben auf der Farbverlaufslinie
unter der Farbbibliothek ändern. Hier ist ein Beispiel dazu.

 

Die Farben eines Fotos wirken realistischer, wenn Sie weniger gesättigte Farben verwenden.

 

Wenn Sie einen fließenden Farbverlauf brauchen (z.B. wenn Sie Farben des Himmels oder der Wiese auswählen),
ziehen Sie die Markierungen weit voneinander; wenn Sie einen schroffen Übergang brauchen, (z.B. wenn Sie Farben für
Augen oder Lippen auswählen), ziehen Sie die Markierungen nah aneinander. Man muss beim Einfärben von Augen und
Lippen solche Farben für die Konturen wählen, die der Gesichtshaut-Farbe entsprechen. Sonst werden die angrenzenden
Bereiche mit der Augen- oder Lippenfarbe gefärbt.

 

Um eine Markierungslinie zu entfernen, benutzen Sie den Radiergummi . Der Hotkey für den Radiergummi ist die

E -Taste.

Wenn Sie die ganze Markierungslinie entfernen wollen, drücken Sie die  Alt -Taste unter Windows, Option  unter Mac

und klicken auf die Linie.

Wenn Sie alle Markierungen entfernen wollen, drücken Sie die Tasten Alt+Strg  unter Windows, Option+⌘  unter Mac

und klicken das Bild an.

 

Um die Farbe einer Markierungslinie zu ändern, aktivieren Sie das Tube-Werkzeug , wählen eine neue Farbe

und klicken auf die Markierungslinie mit der linken Maustaste. Wenn Sie mehrere einfarbige Linien umfärben wollen,
aktivieren Sie das Zaubertube-Werkzeug  und klicken eine dieser Linien an. Alle Linien dieser Farbe werden dann

umgefärbt.

 

Um eine gerade Linie zu ziehen, aktivieren Sie das Stift-Werkzeug , drücken die  Shift -Taste und klicken auf den

ersten und den letzten Punkt der Linie. Auf diese Weise können Sie rechteckige Objekte ganz einfach umreißen.

 

Um komplexe Muster und Objekte mit klaren Grenzen zu kolorieren,  setzen Sie das Stift-Werkzeug in
Multifarben-Modus. Dies spart Ihre Zeit, weil statt mehrere Markierungen zu zeichnen, reicht es eine Linie zu ziehen,
die ihre Farbe entsprechend dem jeweiligen Bereich ändert.

 

Damit es möglich wäre, die Arbeit ans Bild später fortzusetzen, können Sie erstellte Markierungslinien in einer Datei
zu speichern. Es ist nützlich, wenn Sie die Arbeit unterbrechen müssen, bevor Sie allen Objekten eine Farbe zugewiesen
haben oder wenn Sie verschiedene Varianten des Einfärben versuchen wollen. Klicken Sie dafür auf  . Indem Sie auf 

 klicken, können Sie die gespeicherten Markierungen laden und die Bearbeitung wiederaufnehmen. Hier finden Sie ein

Beispiel dazu.

 

Benutzen Sie die Hotkeys, um zwischen verschiedenen Werkzeugen umzuschalten: Stift -  d i e  B -Taste,

Radiergummi - die E -Taste, Farbpipette - die I -Taste, Tube-Werkzeug - die G -Taste.

 

Um den Maßstab des Bildes anzupassen, benutzen Sie die Hotkeys: +  und Strg++  (⌘ ++  unter Mac) zum

Vergrößern des Bildes, -  und Strg+-  (⌘ +-  unter Mac) zum Verkleinern des Bildes.

 

Um die letzten Änderungen rückgängig zu machen, benutzen Sie die Tastenkombination Strg+Z  unter Windows,

⌘ +Z  unter Mac oder klicken Sie auf . Wenn Sie diese Schaltfläche mehrere Male anklicken, werden entsprechend
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viele letzte Handlungen aufgehoben.
Mit dem Befehl  oder mit der Tastenkombination Strg+Y  unter Windows, ⌘ +Y  unter Mac kann die aufgehobene

Handlung wiederholt werden.

 

Wählen Sie in der Registerkarte Musterbild Farben aus dem anderen Foto aus.

 

Verwenden Sie die Vorverarbeitungsparameter für die Vorverarbeitung des Originalfotos. Sie können die Helligkeit und
den Kontrast des Bildes anpassen und es in Graustufen umwandeln.

 

AKVIS Coloriage

34



ANWENDUNG VON FERTIGEN FARBSTRICHEN (*.STROKES-DATEIEN)

Während Färbung eines Bildes in dem Programm AKVIS Coloriage ist es empfehlenswert, die gezogenen Striche von Zeit zu
Zeit in einer Datei mit der Endung .strokes zu speichern, wenn Sie die Bearbeitung aus irgendeinem Grund unterbrechen
müssen. Dann wird es möglich, das Umfärben wieder am gleichen Punkt fortzusetzen, an dem die Arbeit unterbrochen wurde.
Um die Farbstriche zu speichern, klicken Sie auf  und geben Sie einen Dateinamen und einen Speicherort ein.

Später können Sie die Striche aus dieser Datei mit einem Klick auf   laden und die Bearbeitung wiederaufnehmen.

Unter unvorgesehenen Umständen (wie Stromausfall usw.) speichert das Programm die Markierungen automatisch in die
coloriage-autosave.strokes-Datei:

Benutzer\Öffentlich\Öffentliche Dokumente\AKVIS unter Windows;
Users/Shared/AKVIS unter Mac OS.

Das Speichern der Markierungen lässt Ihnen Ihre Erfahrungen mit dem Programm anderen mitteilen.

In unseren Anleitungsbeispielen bieten wir Ihnen häufig eine Datei zum Laden an, wo das Originalbild und die Markierungen
gespeichert sind. Anhand dieser Materialien können Sie das Bearbeitungsverfahren selbständig wiederholen, um die
Arbeitstechnik besser zu verstehen.

Schritt 1. Laden Sie die komprimierte Datei mit dem Originalbild und den Markierungen herunter und dekomprimieren sie.
Schritt 2. Öffnen Sie das Originalbild aus der komprimierten Datei.Schritt 2. Öffnen Sie das Originalbild aus der komprimierten Datei.

Schritt 3. Klicken Sie auf die Schaltfläche  . Wählen Sie die Datei mit der Endung .strokes, dann klicken Sie auf die

Schaltfläche Öffnen.

Schritt 4. Klicken Sie auf die Schaltfläche  . Das eingefärbte Bild wird im Register Ergebnis angezeigt.
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Schritt 5. Sie können die Farben des Bildes nach Ihrem Wunsch ändern. Dazu gehen Sie zurück zum Register Original
und verwenden das Tube-Werkzeug  oder das Zaubertube-Werkzeug . Mit dem Tube-Werkzeug kann die

Farbe von bereits erstellten Markierungslinien geändert werden. Mit dem Zaubertube-Werkzeug kann die Farbe aller
einfarbigen Markierungslinien geändert werden.

Klicken Sie wieder auf die Schaltfläche  .
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Achtung! Die Markierungslinien in der komprimierten Datei entsprechen der Größe des Originalbildes (Breite*Höhe). Wenn Sie
die Größe des Originalbildes ändern, passen die Markierungen nicht mehr.

 

Laden Sie diese Archive herunter und kolorieren Sie die Fotos:

baby-photo.zip, boy-picture.zip, car-color.zip, family-photo.zip, girl-portrait.zip,
house-color.zip, interior.zip, pool-swimmers.zip, postcard.zip, settlers.zip.
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OPTIONEN

Die Schaltfläche   ruft das Dialogfenster Optionen auf. Es sieht so aus:

Sprache. Wählen Sie die gewünschte Sprache aus dem Dropdownmenü aus.
Skalierung des Interfaces. Wählen Sie die Größe von Schnittstellenelementen. Wenn die Auto-Option ausgewählt
wird, erfolgt eine automatische Skalierung des Interfaces auf Basis der Bildschirmauflösung.
Interface. Wählen Sie den gewünschten Stil der Programmschnittstelle: Hell oder Dunkel.
Skalierung. Dieser Parameter legt die Größe des Bildes fest. Es gibt zwei Möglichkeiten:

- Ans Fenster anpassen. Das Bild wird so skaliert, dass es vollständig ins Bildfenster passt;
- Bei dem Parameterwert von 100% wird das Bild nicht skaliert. In den meisten Fällen ist beim Maximalwert nur
ein Teil des Bildes sichtbar.

Das Ergebnis in RGB speichern (nur in der Standalone-Version). Das Bearbeitungsergebnis wird standardmäßig immer
in RGB gespeichert. War das Ausgangsbild im CMYK- oder Lab-Format und wollen Sie das Ergebnis in diesen Modi
abspeichern, deaktivieren Sie diese Option (Beachten Sie: wird das Ergebnis im CMYK-Modus gespeichert, kann es
anders aussehen, als im Bildfenster des Programms). Die Ergebnisbilder in Grayscale-Modus werden immer in RGB
gespeichert.
Zuletzt verwendete Dateien (nur in der Standalone-Version). Legen Sie die Zahl der zuletzt geöffneten Dateien fest,
die durch einen Klick mit der rechten Maustaste auf  angezeigt werden. Maximum: 30 Dateien.

Kästchen Optionsleiste fixieren. Wenn das Kästchen ausgewählt ist, wird die Optionsleiste immer angezeigt. Wählen
Sie diese Funktion ab, um das Bedienfeld zu entsperren, dann können Sie es verstecken/anzeigen, indem Sie auf die
kleine Dreiecksschaltfläche klicken. Um das minimierte Panel anzuzeigen, ziehen Sie mit dem Cursor darüber.
Kästchen  GPU-Nutzung. Wenn das Kästchen aktiviert ist, wird die Bearbeitung durch die Verwendung des
Graphikprozessors beschleunigt. Wenn Ihr Computer diese Möglichkeit nicht unterstützt, bleibt das Kästchen grau (nicht
verfügbar).
Färbungsvarianten. Das Kästchen blendet die Liste mit Färbungsvarianten ein bzw. aus.

Um diese Optionen zu speichern, klicken Sie auf OK.

Um die Standardeinstellungen wieder herzustellen, klicken Sie auf Standardwerte.
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DRUCKEN VON BILDERN IN AKVIS COLORIAGE

Die eigenständige Version von AKVIS Coloriage erlaubt das Drucken des Bildes.
Klicken Sie auf die Schaltfläche  , um die Druckeinstellungen anzupassen.

Druckeinstellungen in AKVIS Coloriage

Passen Sie die Parameter in der Einstellungsleiste an:

Wählen Sie aus der Liste der verfügbaren Drucker den gewünschten Drucker aus. Legen Sie die Anzahl der zu
druckenden Kopien sowie die gewünschte Auflösung fest.

In der Parametergruppe Orientierung legen Sie die Orientierung des Bildes beim Drucken fest: Porträt (vertikal) oder
Album (horizontal).

Klicken Sie auf die Schaltfläche Seiteneinstellungen, um das Dialogfeld zu öffnen, in dem Sie die Seitengröße, die
Orientierung der Seite beim Drucken und die Breite der Kanten festlegen können.

Klicken Sie auf die Schaltfläche Ränder zurücksetzen, um die Standardeinstellungen wiederherzustellen.

Die Parameter Maßstab, Breite und Höhe und das Kästchen Auf Mediengröße skalieren legen die Druckgröße des
Bildes fest. Sie beeinflussen nicht das Bild selbst, sondern seine gedruckte Kopie. Es ist möglich, die Größe der
gedruckten Kopie zu ändern, indem man den Maßstab in Prozent festlegt (ein Wert unter 100% verringert das Bild, ein
Wert über 100% vergrößert es) oder indem man neue Werte für Breite und Höhe einträgt.

Um das Bild auf die ausgewählte Papiergröße zu skalieren, aktivieren Sie das Kästchen Auf Mediengröße skalieren.

Verschieben Sie das Bild mit der Maus oder mit den Pfeiltasten.

Sie können das zu druckende Bild mit einem Rahmen versehen. Die Breite und Farbe des Rahmens sind einstellbar.

Wählen Sie eine Hintergrundfarbe durch einen Klick auf das Farbmuster.

In dem Seite-Register können Sie mehrere Seiten auf ein Blatt Papier drucken lassen.
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Seite drucken

Kopien pro Blatt. Legen Sie fest, wie viele Kopien des Bildes auf ein Blatt Papier gedruckt werden.
Horizontal und Vertikal. Diese Parameter bestimmen, in wie vielen Spalten und Zeilen die Kopien des Bildes
dargestellt werden.
Abstand. Der Parameter stellt den Abstand zwischen den Kopien des Bildes ein.

In dem Poster-Register können Sie ein Bild auf mehrere Blätter verteilt ausdrucken und die Ausdrücke zu einem großen
Poster zusammenfügen.

Poster drucken

Blätter. Wenn das Kontrollkästchen aktiviert ist, können Sie die maximale Anzahl der Blätter festlegen, auf die das
Bild gedruckt wird. Das Bild wird so skaliert, dass es auf die gewünschte Anzahl Druckseiten passt. Wenn das
Kontrollkästchen deaktiviert ist, wird das Programm eine optimale Blattanzahl entsprechend der tatsächlichen
Bildgröße (Maßstab = 100%) automatisch auswählen.
Kleberänder. Aktivieren Sie dieses Kontrollkästchen, um die Breite der Kleberänder einzustellen. Die Ränder
werden rechts und unten gesetzt.
Schnittlinien. Aktivieren Sie dieses Kontrollkästchen, um die Schnittmarkierungen zu drucken. Sie helfen Ihnen
beim Zusammensetzen des Bildes.
Seitenzählung. Aktivieren Sie dieses Kontrollkästchen, um jedes Bildteil zu nummerieren. Nummer der Zeile und
Spalte wird am Rand gedruckt.
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Um den Druckprozess zu starten, klicken Sie auf die Schaltfläche Drucken. 
Um das Dialogfeld ohne Drucken des Bildes zu schließen, klicken Sie auf Abbrechen.

Klicken Sie auf die Schaltfläche  Eigenschaften..., um ein Systemdialogfeld zu öffnen, wo Sie erweiterte Einstellungen
anpassen und das Dokument drucken können.
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SELEKTIVE EINFÄRBUNG

Wir haben schon zahlreiche Beispiele angeführt, in dennen AKVIS Coloriage beim Einfärben schwarz-weißer Fotos benutzt
wurde. Wenn Sie ein Objekt auf dem Bild hervorheben wollen, können Sie eine Farbe nur diesem Objekt hinzufügen. Selektives
Einfärben erzeugt einen Effekt, bei dem das eingefärbte Objekt die Aufmerksamkeit des Betrachters auf sich zieht.

 

Folgen Sie der Anweisung, um ein Element des Bildes zu kolorieren:

Schritt 1. Öffnen Sie das schwarz-weiße Foto mit jungen Sportlern in Ihrem Bildbearbeitungsprogramm.

Schritt 2. Rufen Sie das Plugin AKVIS Coloriage auf.
Schritt 3. Benutzen Sie den Stift , um Farben für die Hauptfigur festzulegen. In diesem Fall wird die Figur des

Gewinners des Stafettenlaufs betont. Wir wählen Farben für seine Kleidung, Haare, Augen, Zähne, Lippen, Haut und für
das Zielband.
Schritt 4. Ziehen Sie eine Kontur um die Hauptfigur herum mit dem Farberhaltungsstift . Wenn das Objekt über die

Grenze des Bildes hinausgeht, lassen Sie die Kontur bis zum Fotorahmen gehen, sodass zwischen ihr und dem
Hintergrund kein Abstand entsteht.

Schritt 5. Klicken Sie auf die Schaltfläche  , um die Bildbearbeitung zu starten.
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Schritt 6. Klicken Sie auf die Schaltfläche  , um das Einfärbungsergebnis anzuwenden.
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SELEKTIVE ENTSÄTTIGUNG

Selektive Entfärbung kann einem Bild einen besonderen Ausdruck verleihen. Wir werden einen Bereich des Bildes entfärben,
ohne die Farben anderer Bereiche zu beeinflussen.

 

Schritt 1. Öffnen Sie das Foto mit einem Schmetterling in Ihrer Bildbearbeitungssoftware.

Schritt 2. Rufen Sie AKVIS Coloriage auf. Dafür in AliveColors wählen Sie den Befehl Effekte -> AKVIS -> Coloriage;
in Adobe Photoshop wählen Sie den Befehl Filter -> AKVIS -> Coloriage; in Corel Photo-Paint - wählen Sie den Befehl
Effekte -> AKVIS -> Coloriage.

Sie können auch die eigenständige Version von AKVIS Coloriage verwenden.

Schritt 3. Aktivieren Sie den Farberhaltungsstift  und ziehen eine Umrisslinie innerhalb des Schmetterlings, um

seine Farbe zu behalten. Sie brauchen die Fühler des Schmetterlings nicht auszuwählen, weil diese schwarz sind und
nach dem Entfärben auch schwarz bleiben.

Schritt 4. Wählen Sie eine graue Farbe (am einfachsten aus der Muster-Palette) und umreißen Sie den Schmetterling
mit dem Stift .
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Schritt 5. Klicken Sie auf , um mit dem Entfärben zu beginnen.

Das Farbbild ist schwarz-weiß geworden; nur Schmetterling hat seine Farben behalten.

Schritt 6. Um das Ergebnis ans Bild anzuwenden, klicken Sie auf .

Sie können auf dieselbe Weise mit anderen Fotos experimentieren, zum Beispiel mit einem Porträt. Selektives Entfärben erlaubt
es, bestimmte Bereiche des Bildes zu betonen und das Foto anders wirken zu lassen.
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UMFÄRBEN EINES AUTOS

Sie können das Foto aus diesem Beispiel mithilfe vom dargestellten Markierungsmuster selbst einfärben. Laden Sie
die Datei mit dem Originalbild und gespeicherten Markierungen (*.strokes) herunter. Lesen Sie die ausführlichen
Informationen dazu hier.

Dieses Beispiel zeigt, wie man die Farbe eines einzelnen Objektes auf dem Foto ändern kann, während die anderen Farben
kostant bleiben.

 

Für Musterbeispiel wurde das Foto eines Autos gewählt.

Bitte folgen Sie dieser Anweisung:

Schritt 1. Öffnen Sie das Originalfoto mit dem Auto.

Schritt 2. Rufen Sie das Plugin AKVIS Coloriage auf. Wählen Sie dafür in AliveColors den Befehl Effekte -> AKVIS ->
Coloriage; in Adobe Photoshop den Befehl Filter -> AKVIS -> Coloriage; in Corel Photo-Paint: Effekte -> AKVIS ->
Coloriage.

Sie können auch die eigenständige Version (Standalone) von AKVIS Coloriage verwenden.

Schritt 3. Wählen Sie eine Farbe für das Auto. Man muss bei der Farbenwahl die Originalfarbe des Autos (Hellgelb)
berücksichtigen. Die Ergebnisfarbe wird standardmäßig auch hell. Es ist also unmöglich, beispielsweise die dunkelblaue
oder weinrote Farbe mit Standardeinstellungen im Ergebnis zu erreichen. Wir wählen deswegen eine helle Farbe aus der
Farbe-Palette (Lila). (Hinweis: wenn Sie doch eine dunkle Farbe wählen möchten, aktivieren Sie das Kästchen
Vorschau der Helligkeit und ändern Sie den Helligkeitsbereich der gewählten Farbe anhand der Farbverlaufslinie).
Schritt 4. Wählen Sie das  Stift-Werkzeug  aus der Werkzeugpalette und ziehen eine Kontur innerhalb des

Fahrzeugkörpers. Da einige Details nicht zum Fahrzeugkörper gehören (Luftschlitz, Türgriff usw.), werden diese mit einer
Linie umrandet und somit aus der Auswahl herausgenommen.
Schritt 5. Wählen Sie den Farberhaltungsstift  aus der Werkzeugpalette und zeichnen Sie eine enge Umrisslinie um

das Auto herum. Die Linie sollte sehr eng ans Auto liegen und alle Objekte enthalten, die nicht zum Wagenkörper
gehören (Scheinwerfer, Hintergrund, Wagendach, Räder usw.). Die Kontur soll unbedingt geschlossen sein. Mit dem
gleichen Werkzeug werden auch die Teile innerhalb des Wagenkörpers markiert, die ihre Farbe behalten sollen, z.B. der
Luftschlitz, die Blinker und die Türgriffe.
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Schritt 6. Klicken Sie auf die Schaltfläche  . Das umgefärbte Bild wird im Register Ergebnis angezeigt.

Schritt 7. Mit einem Klick auf  wenden Sie das Ergebnis auf das Bild an.

Unten sind weitere Varianten des Umfärbens dargestellt:
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ALTE POSTKARTE

Sie können das Foto aus diesem Beispiel mithilfe vom dargestellten Markierungsmuster selbst einfärben. Laden Sie
die Datei mit dem Originalbild und gespeicherten Markierungen (*.strokes) herunter. Lesen Sie die ausführlichen
Informationen dazu hier.

Es steht außer Frage, dass Schwarz-Weiß-Fotos Ihren eigenen Charme haben. Aber manchmal kann das Einfärben ein Foto
von der neuen Seite darstellen und interessante Datails an den Tag legen. Die alte Postkarte aus dem Beispiel wurde unserer
Meinung nach ganz gelungen bearbeitet.

 

Folgen Sie diesen Anweisungen, um der Postkarte neues Leben einzuhauchen:

Schritt 1. Öffnen Sie das Bild in Ihrer Bildbearbeitungssoftware.
Schritt 2. Rufen Sie das Plugin AKVIS Coloriage auf. Wählen Sie dafür in AliveColors den Befehl Effekte -> AKVIS ->
Coloriage; in Adobe Photoshop oder in Adobe Photoshop Elements - wählen Sie den Befehl Filter -> AKVIS ->
Coloriage; in Corel Photo-Paint - wählen Sie den Befehl Effekte -> AKVIS -> Coloriage.
Schritt 3. Wählen Sie eine Farbe für jedes Objekt des Bildes.

Nehmen Sie sich etwas Zeit, um große Objekte umzureißen: die Schärpe, das Kleid, die Felle auf dem Sofa, die Kissen
usw.

Um kleinere Details einzufärben, markieren Sie diese mit feinen einzigen Linien. Z.B. um die Perlen zu kolorieren, reicht
es, eine Linie in der Mtte jeder Kette zu ziehen. Um die Augen einzufärben, reicht es, den Iris und den weißen Bereich
mit Punkten zu markieren.

Schritt 4. Klicken Sie auf die Schaltfläche  , um die Bearbeitung zu starten. Das eingefärbte Bild wird im Register

Ergebnis angezeigt.
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Schritt 5. Nehmen Sie die Änderungen mit einem Klick auf   an.
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AKVIS SOFTWARE

 

AKVIS AirBrush — Airbrush-Technik in Fotos

AKVIS AirBrush lässt Ihre Fotos wie mit einer Spritzpistole gezeichnet aussehen. Weiter…

 

AKVIS Artifact Remover AI — JPEG-Kompressionsartefakte beseitigen

AKVIS Artifact Remover AI verwendet fortgeschrittene Algorithmen der künstl ichen Intell igenz, um JPEG-
Kompressionsartefakte zu entfernen und die ursprüngliche Qualität komprimierter Bilder wiederherzustellen. Die Software ist
kostenlos erhältlich. Es ist ein Muss für Heimanwender und Profis. Entfalten Sie die ganze Schönheit Ihrer Fotos! Weiter…

 

AKVIS ArtSuite — Bilderrahmen und Effekte für Ihre Fotos

AKVIS ArtSuite versieht Digitalfotos mit schönen Bilderrahmen. Ein richtig ausgewählter  Bilderrahmen ergänzt Ihr Bild und
bringt es zur besonderen Geltung. 
Das Programm stellt eine große Auswahl unterschiedlichster Rahmen bereit.  Außerdem erlaubt es, eigene Bilder für die
Erstellung des originellen Rahmens zu benutzen. Weiter…
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AKVIS ArtWork — Vielseitige Sammlung von Maltechniken

AKVIS ArtWork imitiert verschiedene Mal- und Zeichentechniken. Das Programm bietet diese Stilmöglichkeiten an: Ölgemälde,
Aquarell, Gouache, Comic, Tintenzeichnung, Linolschnitt, Pastell und Pointill ismus. Ob ein Ölporträt oder eine
Landschaftsmalerei, das Programm wird Ihre Ideen erfolgreich umsetzen. Weiter…

 

AKVIS Chameleon — Erstellung von Fotocollagen

AKVIS Chameleon ist ein wunderbares Programm für Erstellung von Fotocollagen mit automatischer Adaptierung der
eingesetzten Objekte in Bezug auf die Farbe des Hintergrundes sowie deren Kantenglättung. Das Programm erfordert nicht die
exakte Auswahl der Objekte. Kopieren Sie das Objekt, setzen Sie es in das Bild ein, und er adaptiert die Farbskala des Bildes
und seine Ränder glätten sich. Weiter…
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AKVIS Charcoal — Kohle- und Kreidezeichnungen

AKVIS Charcoal ist ein künstlerisches Werkzeug zur Umwandlung von Fotos in Kohle-, Kreide- und Rötelzeichnungen. Weiter…

 

AKVIS Coloriage — Bildeinfärbung und Farbenänderung

AKVIS Coloriage ändert die Farben eines Fotos: von der Einfärbung Schwarz-Weiß-Fotos bis hin zur Farbenänderung auf Ihren
Farbfotos.
Kein Hantieren mit Ebenen - malen Sie einfach ein paar Striche mit den gewünschten Farben und das Programm erledigt den
Rest. Weiter…

 

AKVIS Decorator — Oberflächengestaltung und Farbveränderung

AKVIS Decorator erlaubt es, die Oberfläche eines Objekts zu verändern. Wählen Sie einen Teil des Bildes aus, z.B. das Kleid
eines Mädchens, und wenden neue Texturen darauf an. Das Mädchen bekommt ein geflecktes oder kariertes Kleid, das
aussieht als wäre es aus Samt oder Seide, oder sogar aus Holz oder Süßigkeiten. Weiter…
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AKVIS Draw — Skizzeneffekt in Fotos

AKVIS Draw lässt Fotos wie mit einem Bleistift gezeichnet aussehen. Die Software funktioniert wie ein Kunstfilter, der Fotos in
stilvolle Skizzen durch Anpassung der Einstellungen umwandelt. Weiter…

 

AKVIS Enhancer — Bildkorrektur und Detailoptimierung

AKVIS Enhancer ist ein Werkzeug, um Bilder zu retten, die wegen falscher Belichtung nicht optimal aussehen. Das Programm
gibt Ihnen die Möglichkeit, Details in unterbelichteten und überbelichteten Bereichen eines Fotos aufzudecken. Das Programm
hat drei Modi: Detailoptimierung, Druckvorbereitung und Tonkorrektur. Weiter…

 

AKVIS Explosion — Spektakuläre Explosionseffekte

AKVIS Explosion bietet kreative Zerstörungs- und Explosionseffekte für digitale Fotos. Das Programm imitiert den Sandsturm-
Effekt und fügt Ihren Bildern fliegende Partikel hinzu. Mit der Software können Sie Ihre Entwürfe ganz einfach explodieren
lassen! Weiter…
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AKVIS Frames — Farbenfrohe digitale Fotorahmen

AKVIS Frames ist eine kostenlose Foto-Editing-Software, die speziell für die Arbeit mit Rahmenpaketen von AKVIS entwickelt
wurde. Mit dem Programm können Sie Ihre Fotos mit exklusiven Bilderrahmen schnell und einfach versehen! Weiter…

 

AKVIS HDRFactory — HDR-Bilder: Über die Wirklichkeit hinaus

AKVIS HDRFactory ist ein vielseitiges Programm zum Erstellen von HDR-Bildern sowie für kreative Gestaltung der Fotos.
HDRFactory erstellt HDR aus mehreren Aufnahmen des gleichen Objekts mit unterschiedlichen Belichtungszeiten. HDRFactory
erlaubt es Ihnen, sogar den HDR-Effekt auf einem Bild nachzuahmen. Das Programm kann auch für Fotokorrektur verwendet
werden. Weiter…

 

AKVIS Inspire AI — Kunstwerke leicht gemacht!

AKVIS Inspire AI stilisiert Bilder anhand verschiedener Gemäldemuster. Das KI-basierte Programm ahmt das Farbschema und
den Stil eines ausgewählten Kunstwerks nach und schafft so ein neues Kunstwerk. Die Software umfasst eine Galerie von
Kunststilen und ermöglicht das Laden eines benutzerdefinierten Musters. Imitieren Sie den Stil weltberühmter Künstler!
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Weiter…

 

AKVIS LightShop — Licht- und Sterneneffekte

AKVIS LightShop erlaubt es Ihnen, eine endlose Zahl von erstaunlichen Lichteffekten zu erstellen! Das Programm bietet
fortgeschrittene Techniken zur Erstellung von Sternen- und Lichteffekten auf Ihren Fotos. Ein Lichteffekt kann jedes Foto
beleben und auffrischen. Fügen Sie Ihren Fotos einen Hauch von Magie hinzu! Weiter…

 

AKVIS Magnifier AI — Bilder vergrößern und Bildqualität verbessern

Mit AKVIS Magnifier AI können Sie Fotos verlustfrei vergrößern und gleichzeitig die Bildqualität verbessern. Mit innovativen
KI-Algorithmen skaliert Magnifier AI Bilder auf eine superhohe Auflösung von bis zu 800% und erstellt wandgroße Drucke.
Verbessern Sie die Bildauflösung, erstellen Sie detaillierte Bilder ohne Verpixelung oder Unschärfe! Weiter…

 

AKVIS MakeUp — Porträtverbesserung

AKVIS MakeUp ist eine Software zur Porträtverbesserung, die Ihren Fotos einen professionellen Look verleiht.

Die Software verfeinert die Hautstruktur auf Porträtaufnahmen und lässt den Teint strahlen. Es ist schon erstaunlich, wie viel
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ein gutes Hautbild zum Verjüngen und Auffrischung des Gesichts beibringen kann. Weiter…

 

AKVIS NatureArt — Natur-Effekte auf digitalen Fotos

AKVIS NatureArt ist ein ausgezeichnetes Werkzeug zur Nachahmung der Schönheit der Naturphänomene auf Ihren digitalen
Fotos. Das Programm enthält eine ganze Reihe von Effekten: Regen

 

AKVIS Neon — Leuchtbilder aus Fotos

AKVIS Neon ist eine Software zur Umwandlung von Fotos in leuchtende Zeichnungen. Das Programm transformiert Fotos in
Neonbilder, die wie mit fluoreszierenden Farben gezeichnet aussehen. Weiter…
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AKVIS Noise Buster AI — Verringerung des Bildrauschens

AKVIS Noise Buster AI verringert Rauschen auf digitalen Bildern. Das digitale Rauschen kann als zahlreiche helle, dunkle oder
farbige Bildpunkte auf einfarbigen Flächen auftreten. Nach der Anwendung sehen Ihre Fotos sauber und fehlerfrei aus. Weiter…

 

AKVIS OilPaint — Ölgemälde-Effekt

AKVIS OilPaint lässt digitale Fotos wie echte Ölgemälde aussehen. Die geheimnisvolle Herstellung eines Gemäldes geschieht
direkt vor Ihren Augen. Der einzigartige Algorithmus erlaubt es, die Technik eines echten Pinsels authentisch zu reproduzieren.
Mit dieser innovativen Software können Sie ein richtiger Künstler werden! Weiter…

 

AKVIS Pastel — Pastellgemälde aus Fotos

AKVIS Pastel verwandelt Ihre Fotos in Pastellgemälde. Das Programm konvertiert Ihre Bilder in lebensechte digitale
Kunstwerke, indem es eine der beliebtesten künstlerischen Maltechniken imitiert. AKVIS Pastel ist ein leistungsfähiges
Werkzeug, um Ihr kreatives Potenzial zu entdecken und auszuleben! Weiter…
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AKVIS Points — Pointillismus-Effekt in Fotos

AKVIS Points verwandelt Ihre digitalen Fotos in Gemälde in pointillistischer Malweise. Diese Technik zählt zu einer der
ausdrucksstärksten Stilrichtungen in der Malerei. Entdecken Sie Geheimnisse des Pointillismus mit AKVIS Points! Weiter…

 

AKVIS Refocus AI — Scharfstellung und Weichzeichnung

AKVIS Refocus AI stellt verschwommene Bilder scharf. Das Programm kann das ganze Foto oder nur einen ausgewählten Teil
davon in den Fokus stellen, damit das Aufnahmemotiv besser zur Geltung kommt. Außerdem ist es möglich, Bokeh- und
Weichzeichnungseffekte auf Ihre Fotos zu erstellen.

Die Software stellt fünf Modi zur Verfügung:  Scharfstellung AI, Iris-Weichzeichnung, Tilt-Shift, Bewegungsunschärfe und
Radiales Weichzeichnen. Weiter…

 

AKVIS Retoucher — Software zur Fotorestaurierung

AKVIS Retoucher ist eine effektive Fotorestaurierungssoftware für Kratzer-und Staubbeseitigung. 
Die Software hilft nicht nur Kratzer, Risse, Schmutz und sonstige Beschädigungen zu beseitigen, sondern auch die fehlenden
Teile des Fotos zu rekonstruieren, indem die angrenzenden Bereiche zur Wiederherstellung herangezogen werden. Weiter…
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AKVIS Sketch — Fotos in Zeichnungen umwandeln

AKVIS Sketch verwandelt Fotos in hochrealistische Bleistiftzeichnungen. Die Software erstellt wunderschöne S/W und farbige
Zeichnungen, die die Technik der Graphit-, Bleistift-, Kohle-, Pastell- und Aquarellzeichnung nachahmen. Das Programm bietet
folgende Zeichenstile: Klassischen, Künstlerischen, Maestro und Multistil - jeweils mit einer Reihe von Voreinstellungen. Mit
AKVIS Sketch brauchen Sie keinen Bleistift, um sich als Künstler zu fühlen! Weiter…

 

AKVIS SmartMask — Objekte aus Foto ausschneiden

AKVIS SmartMask ist ein Maskierungswerkzeug, das die Auswahl schwieriger Objekte innerhalb weniger Sekunden erlaubt,
ohne sie genau zu markieren.

Nie war die Auswahl so einfach! Weiter…
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AKVIS Watercolor — Aquarell-Effekt auf Fotos

AKVIS Watercolor verwandelt Fotos in erstaunlich realistische Aquarellbilder. Das Programm bietet zwei Konvertierungsstile:
Klassisches Aquarell und Kontur-Aquarell. Jeder Stil kommt mit einer großen Auswahl an gebrauchsfertigen Presets. Das
Programm erlaubt es, großartige Meisterwerke mit nur einem Klick erstellen! Weiter…
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